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• Today`s Topic is focus on Developing an 
Android Application

• I will demo an example which get and parse data 
from server

• Assume no experience on developing Android 
code

• Pre-required: JAVA
• Two breaks: 15.10~15.30, 16.20~16.30



Overview
• Why Android?
• What is Android?
• Environment setup
• How to write an Android App?
• A very easy example
• AVD hot keys
• Android Components
• Sample Code & Demo
• Experience Sharing



Why Android?

Android ~70%
Many Manufacturers
Multi-Device issues
Challenge!

iOS~15%



What is Android?
• Based on the Linux kernel
• Designed primarily for touchscreen mobile 

devices such as smartphones and tablet 
computers

• Applications are developed in the Java language 
using the Android software development kit 
(SDK)



Environment setup
1. Install JDK 7
2. Develop Environment setup, eclipse + Android 

SDK
3. Install Android 4.4 SDK and Android 2.3.3 SDK
4. Install AVDs (Android 4.4 and 2.3.3)
5. (Option) Install android mobile phone's USB 

driver for App running

http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html
http://developer.android.com/sdk/index.html
http://developer.android.com/sdk/index.html
http://developer.android.com/sdk/index.html
http://developer.android.com/tools/devices/managing-avds.html


Environment setup

• To compatible to others platform, please setting 
your eclipse

• Window->Preferences->General->Editors-
>Text Editors, check “Insert space for tab”

• Window->Preferences->Java->Code Style-
>Formatter->new profile, select Tab Policy to 
“Spaces Only”

• Window->Preferences->Workspace->Text 
file encoding, check Other and select UTF-8



Why API Level 10



How to write an Android App?
1. Open Eclipse
2. File->New->Android Application Project
3. Fill in Application Name, Project Name, 

Package Name
4. Next->Next->…->Finish



A very easy example
1. Project -> clean
2. Run-> Run Configurations -> Always prompt to 

pick device
3. Run-> Run -> Launch a new Android Virtual 

Device
4. Select AVD 2.3.3 
5. Unlock the screen you will see your App



AVD hot keys

Bug!!
Switch Second 
times will fail

https://code.google.com/p/android/issues/detail?id=13189
https://code.google.com/p/android/issues/detail?id=13189


Android Components
• Activities

– An activity represents a single screen with a user interface. 
– An activity is implemented as a subclass of Activity 

• Services
– A service is a component that runs in the background to perform long-

running operations or to perform work for remote processes.
– A service is implemented as a subclass of Service

• Content providers
– A content provider manages a shared set of application data
– A content provider is implemented as a subclass of ContentProvider 

• Broadcast receivers
– A broadcast receiver is a component that responds to system-wide 

broadcast announcements.
– A broadcast receiver is implemented as a subclass of BroadcastReceiver



Activity
Life Cycle



illustration 1

• Application: Example2
• Add 3 Text View and 

setText to statusCode, 
country, ipAddress 
respectively



Creating An Application

• Create an Activity name Example2
• Min. SDK: API 10
• Target SDK: API 10
• Compile With: API 19



Add Views & members

• res/layout/activity_main.xml
• Add 3 TextView

• id:statusCode , country, ipAddress
• src/com/example/example2/ExampleActivity.

java
• Add members: 3 TextView (name: 

statusCode, country, ipAddress)



Link view’s ID & manipulate

• src/com/example/example2/ExampleActivity.
java

• Add code in function onCreate() {            
                setContentView(R.layout.activity_main);

                  statusCode = (TextView)findViewById(R.id.statusCode);
                  country = (TextView)findViewById(R.id.country);
                  ipAddress = (TextView)findViewById(R.id.ipAddress);
                  statusCode.setText(“statusCode”);
                  country.setText(“country”);
                  ipAddress.setText(“ipAddress “);

}
• Run AVD with Target 2.3.3



illustration 2

• Access Network and get 
JSONData from http://ip-
api.com/json

• Show status, country & 
query in textview 

http://ip-api.com/json
http://ip-api.com/json
http://ip-api.com/json


Connect Network & 
Parse JSON Data

• get JSON data from: http://ip-api.com/json
• {"status":"success","country":"Taiwan",...,"query":"

220.128.223.100"}

• Target: parse “status”, “country”, “query” and 
show in TextView respectively

• Use HttpClient, HttpResponse class to get data
• Use JSONObject to get the data
• Add two functions queryData() & 

parseAndFillData(), and call function in 
onCreate() function

http://ip-api.com/json


Connect Network (Source Code)
// 省略try catch及一些boundary case
 private JSONObject queryData(String URL){
       // Network access
        HttpClient lClient = new DefaultHttpClient();
        HttpGet lGetMethod = new HttpGet(URL);
        HttpResponse lResp = null;
        lResp = lClient.execute(lGetMethod);
        
        // Read JSON data from http response
        ByteArrayOutputStream lBOS = new ByteArrayOutputStream();
        String lInfoStr = null;
        JSONObject jSONObjResponse = null;
        lResp.getEntity().writeTo(lBOS);
        lInfoStr = lBOS.toString("UTF-8");
        jSONObjResponse = new JSONObject(lInfoStr);
        return jSONObjResponse;
    }
    



Parse JSON Data (Source Code)
// 省略try catch及一些boundary case
private void parseAndFillData(JSONObject jObj){
            // parse JSONObject

sts = jObj.getString(STATUS_KEY);
ctry = jObj.getString(COUNTRY_KEY);
ip = jObj.getString(IP_KEY);

// show parse data on TextView
statusCode.setText(sts);
country.setText(ctry);
ipAddress.setText(ip);

}



LogCat + Break Point Debug

• Run previous code on AVD 2.3.3
• Error!!
• not check in parseAndFillData
• not permission on Internet

• Add Uses Permission in AndroidManifest.xml
• android.permission.INTERNET
• re-run again, you will see the correct data
•



Blocking API

• If running on AVD 4.4, 
• Error!!! Why?
• Network Access is Blocking API
• Two Solutions:

• Bypass Blocking API Check
• Run in worker thread

•



Bypass Blocking API Check

• Add code in onCreate() before super.onCreate()
            

StrictMode.setThreadPolicy(new StrictMode.ThreadPolicy.Builder()
.detectDiskReads()
.detectDiskWrites()
.detectNetwork()
.penaltyLog()
.build());

• Not Recommended!!



Run in Worker Thread
• Move queryData & parseAndFillData inside 

thread’s run function
 new Thread(new Runnable(){
         @Override
          public void run() {
                JSONObject jObj = queryData("http://ip-api.com/json");
                parseAndFillData(jObj);
           }
 }).start();

• In Function parseAndFillData(), add 
runOnUiThread()
runOnUiThread(new Runnable(){

@Override
 public void run() {

// origin code in parseAndFillData();
}

});

http://ip-api.com/json


UI Thread

• If missing second step in previous slide, the app
• Crash!
• Logcat output 

CalledFromWrongThreadException
• This exception can’t be bypass

• Android SDK provide AsyncTask for easy use 
for UI thread



AsyncTask

• An asynchronous task is defined by a 
computation that runs on a background thread 
and whose result is published on the UI thread.

• Use AsyncTask when 
• Data which calculated by Thread is shown on 

UI
• Progress UI is shown when Data is 

processing by Thread



How AsyncTask work?

• When an asynchronous task is executed, the 
task goes through 4 steps:
a. onPreExecute() : run on UI Thread
b. doInBackground(Params...): run on worker Thread
c. onProgressUpdate(Progress...): run on UI Thread
d. onPostExecute(Result): run on UI Thread

•



Copy MainActivity and naming 
MainActivity2 

Modify MainActivity2
protected void onCreate(Bundle savedInstanceState) {

...
ipAddressAsyncTask = new AsyncTask<String, Integer, JSONObject>() {            

@Override
            protected void onPreExecute() {
                super.onPreExecute();

            }
@Override

            protected JSONObject doInBackground(String... params) {
                JSONObject result;

                result =queryData(params[0]);
                return result; 

            }
            @Override

            protected void onProgressUpdate(Integer... values) {
                super.onProgressUpdate(values);
            }            

            @Override
            protected void onPostExecute(JSONObject result) {

                super.onPostExecute(result);
                parseAndFillData(result);

            }
        };
        ipAddressAsyncTask.execute("http://ip-api.com/json");

}



Add new Activity in Manifest
& Set to default Activity

• In AndroidManifest.xml
• Application->Add->Activity->Select Activity 

Name (MainActivity2.java)
• Move <intent-filter> ... </intent-filter> into 

MainActivity2 tag
• Save & Run on AVD



illustration 3

• Show Loading bar when 
data not ready



onPreExecute() & 
onProgressUpdate()

onCreate(){

…

   progressDialog = new ProgressDialog(this);      
        progressDialog.setIndeterminate(false);
        progressDialog.setProgressStyle(ProgressDialog.STYLE_HORIZONTAL);
        progressDialog.setMax(5);
        ...

}

@Override
     protected void onPreExecute() {

super.onPreExecute();
progressDialog.show();

    }
    @Override

protected void onProgressUpdate(Integer... values) {
super.onProgressUpdate(values);
progressDialog.setProgress(values[0].intValue());

    }
    



onPostExecute() & 
doInBackground()

    @Override
protected void onPostExecute(JSONObject result) {

  super.onPostExecute(result);
progressDialog.dismiss();
parseAndFillData(result);

    }
    @Override
     protected JSONObject doInBackground(String... params) {

JSONObject result;
result =queryData(params[0]);
publishProgress(0);
for(int i=1;i<=5;i++){
        try{

Thread.sleep(1000);
         }catch (InterruptedException e) { }
        publishProgress(i);
}
return result; 

     }

Add sleep to illustrate the 
function onProgressUpdate()



illustration 4

• Use 
SharedPreferences to 
cache Data

• Show status to “Read 
From CacheData” if 
read data from cache 



Can i cache the data for later 
used?

• Definitely Yes!
• Method

• Shared Preferences
• Write File
• SQLite Databases
• ...

• Today introduce SharedPreferences
• function used: getSharedPreferences(), 

contains(), getString(), edit(), Editor.
putString(), Editor.apply()



Check the preference data
protected void onCreate(Bundle savedInstanceState) {

…
// get the preferencese
cacheData = getSharedPreferences(PREFERENCE_NAME, Context.MODE_PRIVATE);
// if data exists, we can use the cache data
if(cacheData.contains(CACHE_DATA_KEY)){

String jSONString = cacheData.getString(CACHE_DATA_KEY, null);
JSONObject jObj = null;
try {

jObj = new JSONObject(jSONString);
} catch (JSONException e) {

e.printStackTrace();
}

if(jObj!=null){
parseAndFillData("Read From "+CACHE_DATA_KEY, jObj);

}
}

}



Save the data to preference data
private void parseAndFillData(JSONObject jObj){
        if(cacheData!=null && jObj!=null){
            Editor editor = cacheData.edit();
            if(null != editor){
                editor.putString(CACHE_DATA_KEY, jObj.toString());
                editor.apply();
            }
        }
        parseAndFillData(null, jObj);
  }
private void parseAndFillData(String loadingStatus, JSONObject jObj){
        …

          if(loadingStatus!=null)
                sts=loadingStatus;
        else
                sts = jObj.getString(STATUS_KEY);
       …
}
      

Move original code to 
parseAndFillData(null, jObj)



Clear Shared Preferences Data

• Settings→Applications→
     Manage applications→
     APP NAME→Clear data



illustration 5

• Add a button
• Switch to the 

another 
activity when 
button click 
and show 
Button Text to 
“No Function” 

When Button 
Click



Start Another Activity
• Add a button below ipAddress with text=”Goto 

Next Activity” in activity_main.xml
• Use bundle.putString(), intent.setClass(), 

startActivity() to start and pass parameter the 
next activity

•



Start Another Activity
(Sample Code)

protected void onCreate(Bundle savedInstanceState) {

...
gotoNextActivity = (Button)findViewById(R.id.gotoNextActivity );
        gotoNextActivity .setOnClickListener(new Button.OnClickListener(){
           @Override
            public void onClick(View v) {
               Intent intent = new Intent();
               intent.setClass(MainActivity2.this, MainActivity.class);

                     Bundle bundle = new Bundle();
                     bundle.putString(MainActivity.CHANGE_BUTTON_TEXT_KEY,”No Function”);
                     intent.putExtras(bundle);

               startActivity(intent);
            } 
        });

}

// in next Activity

protected void onCreate(Bundle savedInstanceState) {

…
Bundle bundle = getIntent().getExtras();
String showButtonText = bundle.getString(MainActivity2.CHANGE_BUTTON_TEXT_KEY);
gotoNextActivity.setText(showButtonText);

    }



Service
• A Service is an application component that can perform 

long-running operations in the background and does not 
provide a user interface.

• When use Service? Do something user no need aware 
it
• Recieve Message
• Download/Upload Data
• ...



Service Lifecycle



illustration 6

• Similar to illustration 2 but 
using Service + Broadcast 
receiver



IntentService & 
Broadcast message

• Add 3 classes which extended IntentService, 
BroadcastReceiver and Activity respectively

• In IntentService,
@Override
 protected void onHandleIntent(Intent intent) {
        // function called when someone call StartService(intent)
        String url = intent.getExtras().getString(URL_KEY);
        JSONObject jObj = queryData(url);
        publishResults(jObj.toString());
    }
private void publishResults(String result) {
        // broadcast message
        Intent intent = new Intent(NOTIFICATION);
        intent.putExtra(MainReciever.JSONSTRING_KEY, result);
        sendBroadcast(intent);
    }



BroadcastReciever
• In BroadcastReceiver

@Override
    public void onReceive(Context context, Intent intent) {
        // Show a message in UI
        Toast.makeText(context, "Broadcast Intent Detected.", Toast.LENGTH_LONG).show();
        if(activity!=null){
            String jString = intent.getExtras().getString(JSONSTRING_KEY);
            JSONObject jObj=null;
            try {
                jObj = new JSONObject(jString);
            } catch (JSONException e) {
                e.printStackTrace();
            }
            activity.parseAndFillData(jObj);
        }
    }

Reference activity and call its 
member method



How to Use Service & Broadcast 
receiver

• In Activity
@Override

    protected void onCreate(Bundle savedInstanceState) {

…

// Start Service with intent

Intent intent = new Intent(this, MainService.class);

 intent.putExtra(MainService.URL_KEY, "http://ip-api.com/json");

startService(intent);

// Register Reciever

mainReciever = new MainReciever(this);

registerReceiver(mainReciever, new IntentFilter(MainService.NOTIFICATION));

}

@Override

    protected void onDestroy() {

        // Unregister Reciever

        unregisterReceiver(mainReciever);

        super.onDestroy();

    }

http://ip-api.com/json


Add Intent-Filter to activate 
corresponding function

• Add activity, service and reciever in Manifest
• Because reciever need process Intent, so we 

need to add intent filter for reciever
<intent-filter>

<action android:name="com.example.example2.MainReceiver"/>

</intent-filter>

• Set Activity to Startup Activity
<intent-filter>

<action android:name="android.intent.action.MAIN" />

<category android:name="android.intent.category.LAUNCHER" />

</intent-filter>

• Run App 



IDE Provide Some Useful 
Functions

• Right click select source → generate xxx to 
generate source code

• Import related library (Ctrl+Shift+O )
• F3: jump to the function or variable definition
• Use Breakpoints/Logcat to debug code
• In debug mode

• F5: step into
• F6: step over
• F8: resume



How to deploy a good App?
• Treat seriously about the try-catch block
• Use lint tool to scan potential error
• Do not ignore any compiler warning! 
• Must run App on a real platform
• Test multi-device, ex: screen size, cpu speed, RAM 

size,...
• Do not skip any logcat’s warning (including system log)
• Do not fix bug on a specify phone if it is a multi-device 

issue
• Search multi-device issues on Google and find solution!



iKala Android App



■ 想學習更多手機、後端技術嗎?
■ 想與一流的團隊一起工作嗎?
■ 想展現你的實力嗎?

■ 系　　所：大專或專科資訊相關科系 ( 強者不受此限制) 
■ 工作內容：iOS app、Android app、後端系統開發
■  熟悉的程式語言：C/C++, Java, Objective-C 
■ 工作時間：非常彈性，一個禮拜一天或是每天來都可以
■ 時　　薪：170 元以上
■ http://event.ikala.tv/2013/11/intern/index.html

iKala 徵才中!
履歷請寄朱佩霜小姐 shelly@ikala.tv 

 

實習生
招募中

http://event.ikala.tv/2013/11/intern/index.html
mailto:shelly@ikala.tv

